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EXCEL CHAPTER 9:  MULTIPLE-SHEET WORKBOOK MANAGEMENT
Available Instructor Resources
	Resource
	File Name
	Found

	Student Data Files
	various
	Online Instructor Resource Center

	Solution Files
	various
	Online Instructor Resource Center 

	Answer Keys 
	 
	Online Instructor Resource Center 

	      Matching
	e09_answerkey_match
	

	      Multiple Choice
	e09_answerkey_mc
	 

	      Concepts Checks
	e09_answerkey_concepts
	 

	Scorecards
	e09b1Tips_scorecard
	Online Instructor Resource Center 

	Scoring Rubrics
	e09b1Tips_rubric
	Online Instructor Resource Center 

	Annotated Solution File
	e09b1Tips_annsolution
	Online Instructor Resource Center 

	Scripted Lecture (Script)
	e09_script
	Online Instructor Resource Center 

	    Scripted Lecture Solution
	e09_script_solution
	

	    Scripted Lecture Data
	e09_script_data
	 

	PowerPoint Presentation
	e09_powerpoints
	Online Instructor Resource Center 

	Testbank
	e09_testbank
	Online Instructor Resource Center 

	Instructor's Manual (lesson plans incl.)
	e09_instructormanual
	Online Instructor Resource Center 

	Assignment Sheet
	e09_assignsheet
	Online Instructor Resource Center 

	Prepared Exam (Chapter & App)
	 
	Online Instructor Resource Center 

	      Prepared Exam-Chap instruction
	e09_exam_chap_instruction
	

	      Prepared Exam-Chap solution
	e09_exam_chap_solution
	

	      Prepared Exam-Chap Data
	e09_exam_chap_data
	

	      Prepared Exam-Chap Annotated Sol.
	e09_exam_chap_annsolution
	

	      Prepared Exam-Chap Scorecard
	e09_exam_chap_scorecard
	

	      Prepared Exam-App instruction
	e09_cumexam_instruction
	 

	      Prepared Exam-App solution
	e09_cumexam_solution
	 

	      Prepared Exam-App Data
	e09_cumexam_data
	 

	      Prepared Exam-App Annotated Sol.
	e09_cumexam_annsolution
	 

	      Prepared Exam-App scorecard
	e09_cumexam_scorecard
	 

	File Guide
	e09_file_guide
	Online Instructor Resource Center 

	Instructor Resource Card
	e09_ircard
	Online Instructor Resource Center 

	Objective Map
	e09_objectivesmap
	Online Instructor Resource Center 

	Online Chapter Review
	e09_chapt_checklist
	Companion Website for Students

	Grader Project
	 
	 

	       Grader-instruction
	e09_grader_instruction
	Online Instructor Resource Center 

	       Grader-solution
	e09_grader_solution
	

	       Grader-data
	e09_grader_data
	

	       Grader-annoted. Solution
	e09_grader_annsolution
	 

	       Grader-scorecard
	e09_grader_scorecard
	 

	Additional Projects (Practice & Mid Level)
	 
	Online Instructor Resource Center 

	       Additional Proj-Practice instruction
	e09_p_addproject_instruction
	

	       Additional Proj- Practice solutions
	e09_p_addproject_solution
	

	       Additional Proj-Practice Data
	e09_p_addproject_data
	

	       Additional Proj-Practice Ann Sol.
	e09_p_addproject_annsolution
	

	       Additional Proj-Practice Scorecard
	e09_p_addproject_scorecard
	

	       Additional Proj-Mid Level instruction
	e09_ml_addproject_instruction
	 

	       Additional Proj-Mid Level solutions
	e09_ml_addproject_solution
	

	       Additional Proj-Mid Level Data
	e09_ml_addproject_data
	

	       Additional Proj-Mid Level Ann Sol.
	e09_ml_addproject_annsolution
	 

	       Additional Proj-Mid Level Scorecard
	e09_ml_addproject_scorecard
	 



CHAPTER OBJECTIVES 
When students have finished reading this chapter, they will be able to:

· Work with grouped worksheets
· Manage windows and workspaces
· Insert hyperlinks
· Insert a 3-D formula
· Link workbooks
· Audit formulas
· Set up a Watch Window
· Validate data




CHAPTER OVERVIEW
The major sections in this chapter are:
Multiple Worksheets: Working with grouped worksheets; managing windows and workspaces; inserting hyperlinks
3-D Formulas and Linked Workbooks: Inserting a 3-D formula; linking workbooks
Formula Audits and Data Validation: Auditing formulas; setting up a Watch Window; validating data
CLASS RUNDOWN
1. Have students turn in homework assignments.
2. Talk about chapter using discussion questions listed below. 
3. Use PowerPoint presentation to help students understand chapter content.
4. Demonstrate Excel 2013.
5. Run through Scripted Lectures for chapter.
6. Have students complete Capstone Exercise for Excel Chapter 9.
7. Use MyITLab for in-class work or to go over homework.
8. Give students Homework Handout for next class period. 

LEARNING OBJECTIVES
At the end of this lesson students should be able to:

· Group and fill across worksheets
· Enter and format data across worksheets
· Insert hyperlinks
· Open and arrange worksheets
· Insert worksheet references
· Insert 3-D formulas
· Link workbooks
· Complete the linked workbook
· Trace precedents and dependents
· Check for errors
· Set up a Watch Window
· Create a validation rule
· Specify inputs and alerts
KEY TERMS
Chapter X: Title	
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3-D formula – A formula or function that refers to the same range in multiple worksheets, such as =SUM(January:December!C5).
Data validation – A setting that requires that rules be followed in order to allow data to be entered in a cell.
Dependent cell – A cell containing a formula that is dependent on other cells to obtain its value.
Destination file – A file that contains a pointer to the source file.
Error alert – A message that appears when the user enters invalid data in a cell containing a validation rule.
Formula auditing – Tools to enable you to detect and correct errors in formulas by identifying relationships among cells.
Grouping – The process of selecting worksheets to perform the same action at the same time.
Hyperlink – An electronic marker to another location in a worksheet, workbook, file, Web page, or e-mail.
IFERROR function – A logical function that checks a value and returns the result if possible or an error message.
Input message – A description or instructions for data entry.
Linking – The process of connecting cells between worksheets.
Logic error – An error that occurs when a formula adheres to syntax rules but produces inaccurate results.
Precedent cell – A cell that is referenced by a formula in another cell.
Source file – A file that contains original data.
Split bar – A vertical or horizontal line that frames panes in a worksheet and enables the user to resize the panes.
Splitting – The process of dividing a worksheet window into resizable panes to enable viewing separate parts of a worksheet at the same time.
Syntax error – An error that occurs when formula construction rules are violated.
Tracer arrow – A colored line that indicates relationships between precedent and dependent cells.
Ungrouping – The process of deselecting worksheets that are grouped.
Validation criteria – Rules that dictate the data to enter in a cell.
Watch Window – A window that enables you to view formula calculations.
DISCUSSION QUESTIONS
· Why is cross-checking data important? Which type of problems might arise if cross-checking is not performed? Can you think of some real-life examples where cross-checking would have prevented a problem?
· Which type of security issues may arise when linking workbooks? 
· How does avoiding the use of constants in a spreadsheet help avoid errors?
WHEN USING SCRIPTED LECTURE IN CLASS, DEMONSTRATE HOW TO:
· Group and fill across worksheets
· Enter and format data across worksheets
· Insert hyperlinks
· Open and arrange worksheets
· Insert worksheet references
· Insert 3-D formulas
· Link workbooks
· Complete the linked workbook
· Trace precedents and dependents
· Check for errors
· Set up a Watch Window
· Create a validation rule
· Specify inputs and alerts
CONNECTIONS PRACTICAL PROJECTS AND APPLICATIONS
· Have students create their own gradebook and cross-check their grades against those in your online gradebook (assuming you are using a course management system or MyITLab). They should insert additional worksheets for other classes or other units in your class. 
· Have students create an organizational budget—assign groups to different “cost centers,” which have similar budget categories. Create a 3-D reference to add up budget allocations between three departments. 
TEACHING NOTES
Multiple Worksheets 

 Deciding how to structure data into multiple worksheets and how to manage these worksheets is important. 
A. Working with Grouped Worksheets
· By default, new workbooks open with one worksheet. You can change the number of default sheets by going to File tab  Options  General  When Creating New Workbooks section. Choose the number of sheets wanted from the Include This Many Sheets box. 
· Teaching Tip:  Make sure that you ungroup worksheets when you want to perform a task on only one worksheet. If you forget to ungroup sheets, you could potentially ruin several worksheets by overwriting data on all worksheets instead of just the active worksheet.
· Teaching Tip: Some tasks are not available on grouped worksheets. These tasks appear grayed out on the Ribbon or in menus. For example, you cannot apply conditional formatting or format data as a table on grouped worksheets. Most commands such as PivotTable on the Insert tab are unavailable for grouped worksheets.
· Teaching Tip: Excel disables the Conditional Formatting feature when you group worksheets. You cannot group worksheets and then create and manage conditional formats. However, you can create a conditional formatting rule on one worksheet, group the worksheets, and then use the Fill Across Worksheets command to replicate the conditional formatting rule to a range on other worksheets.
B. Managing Windows and Workspaces
· Want to view multiple sheets at the same time? Click the tab of a sheet you want to view, then from the View tab, choose New Window. Repeat these steps until you have all the sheets you want open in an individual window. From the View tab, click Arrange All, and select a viewing option. 
· Teaching Tip: The Window group on the View tab contains options to enable you to view two worksheet windows side by side and synchronize the scrolling for both windows or enable separate scrolling. If you have adjusted the window sizes, you can reset the open worksheet windows to share the screen equally. In addition, you can hide a worksheet if you do not want to display it, or you can display a previously hidden worksheet window. However, you cannot use the Freeze Panes settings and split bars at the same time.
C. Inserting Hyperlinks
· If you do not want to automatically include hyperlinks, you can turn them on or off in the AutoCorrect dialog box. 
· Teaching Tip: You have the ability to add hyperlinks to more than just text. You have the ability to add links to inserted images and objects as well.
· Teaching Tip: To modify a hyperlink, right-click it, and then select Edit Hyperlink to open the Edit Hyperlink dialog box, which is similar to the Insert Hyperlink dialog box. Make the desired changes and click OK. To remove a hyperlink, right-click it and select Remove Hyperlink. This action removes the hyperlink but does not delete the cell contents or object.
· Teaching Tip:  If a hyperlink does not jump to the correct range and worksheet, right-click the cell containing the wrong hyperlink, click Edit Hyperlink, and then edit the hyperlink in the Edit Hyperlink dialog box.

3-D Formulas and Linked Workbooks 

Workbooks often contain data from different time periods, geographic regions, or products. 
A. Inserting a 3-D Formula
· To sever a link between the cell containing the original value or formula and the cell to which it’s been linked, edit the linking formula. Press F2, then immediately recalculate the formula by pressing F9, and pressing Enter. 
· Remind students that 3-D references change when you move, copy, insert, or delete worksheets. Inserting or copying worksheets between the endpoints will include the values in the cells in the added worksheets; deleting removes those values. 
· Remind students that an endpoint is at EITHER end of the reference—the “starting” worksheet is also an endpoint. 
· Teaching Tip: CamelCase notation is a file naming convention that eliminates spaces and capitalizes compound words—for example, OctoberSales.xlsx versus October sales.xlsx. By using a naming convention such as CamelCase, you can reduce some of the complexity of a 3-D formula by eliminating the need for single quotation marks.
· Teaching Tip: When you have a function such as =SUM(B1:B5) and insert a new fourth row, Excel modifies the SUM function to include the new row: =SUM(B1:B6). Similarly, if you insert or copy a worksheet between the beginning and ending worksheet references, the 3-D formula automatically includes those worksheet data points in the calculation. If you move a worksheet out of the range, Excel excludes that worksheet’s values from the 3-D formula calculations. Finally, if you move or delete an endpoint worksheet, Excel adjusts the 3-D formula for you.
· Teaching Tip: Excel updates an external reference regardless of whether the source workbook is open. The source workbooks must be in the same folder location as when you created the link to update the destination workbook. If the location of the workbooks changes, as may happen if you copy the workbooks to a different folder, click Edit Links in the Connections group on the Data tab.
Formula Audits and Data Validation 

Errors can render a worksheet or workbook useless; Excel can help detect and correct errors with formula auditing tools.  
A. Auditing Formulas
· Formula auditing helps pinpoint problems—and Excel has two ways to audit a formula. First, highlight references in the formula bar and press F9 to evaluate just the highlighted component. Students also can use the Evaluate Formula tool in the Formula Auditing group on the Formulas tab. 
· Students should know how to reveal all the formulas in their spreadsheet—Ctrl+` is a toggle that will reveal formulas and then return the spreadsheet to “normal” quickly and easily. 
· Teaching Tip: Excel detects potential logic errors even if the formula does not contain a syntax error. For example, Excel might detect that =SUM(B2:B5) contains a potential error if cell B1 contains a value, assuming the possibility that the function might need to include B1 in the range of values to add. When this occurs, Excel displays a green triangle in the top-left corner of the cell. Click the cell containing the green triangle and click the error icon, the yellow diamond with the exclamation mark, to see a list of options to correct the error.
· Teaching Tip: Click Remove Arrows in the Formula Auditing group on the Formulas tab to remove all tracer arrows, or click the Remove Arrows arrow and select Remove Arrows, Remove Precedent Arrows, or Remove Dependent Arrows.
· Teaching Tip: The Information functions contain additional functions you can use for error checking. Of particular interest are the ERROR.TYPE and ISERROR functions. Use Help to learn how to incorporate these functions in error-checking tasks.
B. Setting up a Watch Window
· Inquire is a new feature in Excel 2013 that allows users to analyze, audit, and review workbooks—it allows a better understanding of design and function, including data dependencies, potential errors, and security concerns. 
· Excel remembers the cells in a Watch Window even between sessions—if you close the workbook with cells being monitored, those cells are removed from your Watch Window. But if you reopen it, the cells are displayed again. 
· Teaching Tip: Any time you make a change to the watched cell(s), the Watch Window shows you the current value of the watched cell(s).
C. Validating Data
· Teaching Tip: After defining data validation rules, you can display circles around invalid text. To display circles for invalid data, click the Data Validation arrow in the Data Tools group and select Circle Invalid Data. When the user corrects the invalid data, the circles disappear.
· Teaching Tip: If you wish to edit the validation message that was set up after completing that step, you can edit the validation rule by reentering the data validation menu.
ONLINE CHAPTER REVIEW
To find an online chapter review to help your students practice for tests, visit the Companion Website at http://www.pearsonhighered.com/exploring/.
ADDITIONAL WEB RESOURCES
1. What's new in Excel 2013—http://office.microsoft.com/en-us/excel-help/what-s-new-in-excel-2013-HA102809308.aspx
2. Online Excel Help—www.mrexcel.com  
3. Microsoft Tech Support—http://support.microsoft.com  

PROJECTS AND EXERCISES
	
	Data file
	Save As

	Hands-on Exercise 1
	e09h1Indianapolis.xlsx
	e09h1Indianapolis_LastFirst.xlsx

	Hands-on Exercise 2
	e09h1Indianapolis_LastFirst.xlsx, e09h2Bloomington.xlsx, e09h2SouthBend.xlsx, e09h2Indiana.xlsx
	e09h2Indianapolis_LastFirst.xlsx, e09h2Bloomington_LastFirst.xlsx, e09h2SouthBend_LastFirst.xlsx, e09h2Indiana_LastFirst.xlsx

	Hands-on Exercise 3
	e09h3FortWayne.xlsx
	e09h3FortWayne_LastFirst.xlsx

	Practice Exercise 1
	e09p1Downtown.xlsx, e09p1North.xlsx, e09p1Quarter1.xlsx, e09p1South.xlsx
	e09p1Downtown_LastFirst.xlsx, e09p1North_LastFirst.xlsx, e09p1Quarter1_LastFirst.xlsx, e09p1South_LastFirst.xlsx

	Practice Exercise 2
	e09p2Retire.xlsx
	e09p2Retire_LastFirst.xlsx

	Mid-Level Exercise 1
	e09m1Sales.xlsx
	e09m1Sales_LastFirst.xlsx

	Mid-Level Exercise 2
	e09m2June.xlsx,
e09m2July.xlsx, e09m2August.xlsx, e09m2Summer.xlsx
	e09m2June_LastFirst.xlsx, e09m2July_LastFirst.xlsx, e09m2August_LastFirst.xlsx, e09m2Summer_LastFirst.xlsx

	Mid-Level Exercise 3
	
	e09m3BookClub_LastFirst.xlsx

	BYC 2 Research
	e09b2Country.xlsx, 
e09b2Trip.xlsx
	e09b2Country1_LastFirst.xlsx, e09b2Country2_LastFirst.xlsx, e09b2Trip_LastFirst.xlsx

	BYC 3 Disaster Recovery
	e09b3Grades.xlsx
	e09b3Grades_LastFirst.xlsx

	BYC 4 Collaboration
	e09b4Workspace.xlsx
	e09b4Workspace_LastFirst.xlsx, e09b4Workspace_LastFirst.xlw

	Capstone
	e09c1Theater10.xlsx, e09c1Theater11.xlsx, e09c1Theater12.xlsx, e09c1TheaterQ4.xlsx
	e09c1Theater10_LastFirst.xlsx, e09c1Theater11_LastFirst.xlsx, e09c1Theater12_LastFirst.xlsx, e09c1TheaterQ4_LastFirst.xlsx



CHAPTER REVIEW/ANSWERS TO END OF CHAPTER MATERIAL

Key Terms Matching Answer Key

1. 	A Syntax error (Q) occurs when formula construction rules are violated.
2. 	A Hyperlink (H) is an electronic marker to another location in a worksheet, workbook, file, Web page, or e- mail.
3. 	Validation criteria (T) are rules that dictate the data to enter in a cell.
4. 	The IFERROR function (I) checks a value and returns the result if possible or an error message.
5. 	The Destination file (D) is a file that contains a pointer to the source file.
6. 	Data validation (B) requires that rules be followed in order to allow data to be entered in a cell.
7. 	Formula auditing (F) includes tools to enable you to detect and correct errors in formulas by identifying relationships among cells.
8. 	A Tracer arrow (R) is a colored line that indicates relationships between precedent and dependent cells.
9. 	Linking (K) is the process of connecting cells between worksheets.
10. 	Grouping (G) is the process of selecting worksheets to perform the same action at the same time.
11. 	Splitting (P) is the process of dividing a worksheet window.
12. 	Ungrouping (S) is the process of deselecting worksheets that were grouped.
13. 	A Split bar (O) is a vertical or horizontal line that frames panes in a worksheet and enables the user to resize the panes.
14. 	A Dependent cell (C) is a cell containing a formula that is dependent on other cells to obtain its value.
15. 	A Logic error (L) occurs when a formula adheres to syntax rules but produces inaccurate results.
16. 	A 3-D formula (A) is a formula or function that refers to the same range in multiple worksheets.
17. 	The Source file (N) is a file that contains original data.
18. 	A Precedent cell (M) is a cell that is referenced by a formula in another cell.
19. 	An Error alert (E) is a message that appears when the user enters invalid data in a cell containing a validation rule. 
20.	An Input message (J) is a description or instructions for data entry.
Multiple Choice Answer Key
1. You have a workbook that contains sales data for different regional sales reps of a company. Which task is the least likely to be done while the worksheets are grouped?
(c) Enter specific values for the first sales rep. 
2. Your manager sent you a workbook that contains data validation rules. One rule specifies a maximum value of 15% with a warning alert. You try to enter 22% in that cell. What happens?
(d) Excel displays a message box informing you the value is above the maximum value and lets you choose to go ahead and enter that value or a different value. 
3. The function =FV(D10,D8,-D5) is entered in cell D12. Which cell is a dependent of cell D8?
(b) D12
4. If you want to display a portion of all three worksheets in a workbook, what should you do?
(a) Open two new workbook windows, arrange windows, and then click a different worksheet tab in each window. 
5. Which function cannot be used in a 3-D formula?
(d) PMT
6. A personal trainer stores how much weight each person can lift in several categories. Each week’s data are stored in a separate worksheet within the same workbook, and each worksheet has an identical structure. Assume cell F5 contains the weight the first person can bench press. What function can identify that person’s highest amount bench-pressed in all worksheets?
(c) =MAX(‘Week 1:Week 4’!F5)
7. You want to create a hyperlink within your document to the SEC website. Which type of link do you create?
(a) Existing File or Web Page
8. To study the results of a formula on the Summary worksheet when you change an input value on the Input worksheet, what can you do?
(a) Create a watch for the formula and display the Watch Window while changing the input value on the Input worksheet. 
9. You are preparing an accreditation report for your university. You have several workbooks of data for each college, such as Arts, Sciences, and Business. Assuming the individual workbooks are stored in the same folder as the University workbook, how would a link to cell B15 in the Digital Media worksheet in the School of Computing workbook appear in the University workbook?
(c) =‘[School of Computing.xlsx]Digital Media’!$B$15
10. Which dialog box specifies a cell containing an error and the type of error, such as Divide by Zero Error?
(d) Error Checking 
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